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describing 256 levels of gray, the scan is 32
bit (232) to accommodate the 16.7 million
colors available to the printer.

Printing Digital Images

It is important for a managing editor to
understand the basics of the printing
process. This process is the basis for the
requirements that typesetters and printers
impose on the processing of digital image
information.

Screening

The machine that interprets the informa-
tion in a digital file and creates an image
on film is called an imagesetter. When the
digital image is sent to the imagesetter, a
grid is created over the image with 150
lines/inch in each direction (the screen rul-
ing). In a halftone image, the value
assigned to each point on the grid will be
an average of the information from the
300-dpi scan. Each tonal value (from 0 to
255) is translated into a dot. The imageset-
ter has a resolution equal to 16 times the
screen ruling (16 X 150 = 2400 dpi); thus,
each point on the 150-line/inch grid can
be made up of a grid of 16 X 16, giving
256 possible dot sizes. The differently sized
dots fool the eye into seeing different
shades of gray, even though only black ink
is placed on the paper. A good way to see
how an image in a journal is created from
dots is to look at a printed halftone
through a magnifying glass.

Offset Lithography

This is the term for the printing process
used by scientific journals. The dots on the
film produced by the imagesetter are trans-
ferred to an aluminum plate, which has a
coating where exposed areas (dots) are
attracted to ink and unexposed areas are
attracted to water. The plate passes by ink
and water rollers, and the ink it picks up is
then transferred to a rubber roller, which
in turn transfers the ink to paper. Strong
pressure is applied to the sheet of paper in
the process, and one result is that the dots
that make up an image typically come out

188 ¢ CBE VIEWS

larger on paper than they are on the plate;
this is referred to as dot gain.

The Press Curve

The printer creates a press curve to com-
pensate for dot gain, essentially adjusting
the size of the dots from the imagesetter to
counteract their increase in size in the
printing press. In addition to an actual
dot-gain setting, the press curve has a set-
ting for “gamma” output, which regulates
the contrast between the lightest and dark-

The figure proofs that are
sent to authors cannot
possibly be an exact
representation of the way
the figures will look on the
printed page.

est parts of an image, and a setting for tonal
range. The tonal range is set so that no dots
will be larger than a specified percentage of
the maximum (for example, 98%); this
avoids bleeding of one dot into another,
potentially losing detail in the shadow area
of an image. Conversely, the white or
“highlight” areas of an image cannot be
totally without ink; the smallest dot is set
to a specified percentage greater than the
minimum (for example, 2%) so that detail
in the highlight area is not lost.

Printing Color

Color images are printed by separating their
colors into 4 components: cyan, magenta,
yellow, and black (CMYK). The separation
can be done by a scanner, and this process is
what printers are referring to when they talk
about a “separation”. Each of the colors in an
image is created by assigning a percentage of
0 to 100 to each of the aforementioned col-
ors (for example, a red color could be created
from 0% cyan, 100% yellow, 100%
magenta, and 0% black). These numbers are
transformed into dot densities on 4 separate
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pieces of film (1 for each color), which are
used to create 4 plates. The color image is
then printed on a multipass or multiplate
press, with a single piece of paper receiving
ink from each of 4 plates.

CMYK is referred to as subtractive
color (that is, black is achieved by the pres-
ence of all inks), as opposed to RGB (red,
green, and blue), which is additive color
(that is, white is achieved by the presence
of all 3 colors as lightwaves). RGB is the
color process used by computer displays
and can generate many more colors than
can be generated by CMYK. In particular,
many magentas and purples are difficult to
create in CMYK, and authors should con-
sider avoiding these colors when preparing
an image for publication.

Printers’ Proofs

One of the most important issues for a
managing editor to appreciate, based on an
understanding of the printing process, is
that the figure proofs that are sent to
authors cannot possibly be an exact repre-
sentation of the way the figures will look
on the printed page, as they have not gone
through the rollers of the printing press.
The typesetter uses a proofing output
device to simulate the tonal effects, color
effects, and dot gain of the printing
process. Typesetters make great efforts to
calibrate their proofing devices to ensure
that the output matches the printed prod-
uct as closely as possible. It is important,
however, for editors to let their typesetters
know that they want proofs to be equal to
or slightly less than print quality, so that
authors are not disappointed when they see
the print version.

Another tool that a typesetter may use to
prepare proofs is image-swapping technol-
ogy known as an open prepress interface
(OPI) or automatic picture replacement
(APR) to produce page proofs for authors.
The process allows a low-resolution version
of an image to be inserted into the page lay-
out for placement, so the proofs can be
printed much more quickly. The low-resolu-
tion image is swapped for the high-resolu-



tion version when the file is sent to the
imagesetter. The use of this technology can
affect the format of digital images that can
be used by the typesetter (see below).

Problems with Scanning Images
The main problem with scanning images
stems from the fact that authors frequently
use digital data-capture devices and produce
their figures (both images and line art) with
computer software. That is, the first genera-
tion of the figure is electronic, and a good
(for example, continuous tone) paper copy
may not necessarily exist. The output of a
digital file by an author on cither a laser
printer or a color dye-sublimation printer is
produced by a process similar to that
described above, in which a PostScript intet-
preter (the printer driver) creates a pattern of
dots, which is placed on paper. The pattern
is made up of a specified number of dots per
inch, which is referred to as the /ine screen of
the image.

When a typesetter scans such an image,
a second line screen is applied, and that
rescreening process can corrupt the unifor-
mity of the black and white mix produced
by different-size dots in the gray portions
of an image. This is because it is virtually
impossible to line up the line screen of the
image with the sampling line screen of the
scanner. For 1-bit line art, the scanner will
not see perfect black or white points on the
image; since it can only fill or not fill each
point, the scanner must interpret the
mixed points and decide whether to fill or
not fill the point in the file that it creates.
The result can be an undesirable wavy pat-
tern in the scanned image called a moiré.
(For a more detailed discussion of this
issue, including a very helpful discussion of
how to produce line art with less propen-
sity to yield moiré patterns when scanned,
see reference 2.)

Digital Images from Authors

Authors want typesetters and printers to use
their digital image files. They want to avoid
the possible loss of quality associated with
creating a paper copy and having it scanned,

and they would prefer to avoid the cost of
producing camera-ready paper copy. It is
also vastly easier to label, crop, and collage
figures in the digital environment. Because it
is always in managing editors’ interest to try
to accommodate authors” wishes, they must
understand the problems associated with
using these files and be able to communicate
to authors the best way to avoid many of the
problems.

Managing editors must
provide detailed instructions
to authors, describing the
correct settings for files to be
used by the typesetter and

printer.

Data Integrity

The first problem of which both authors
and editors must be aware is the risk to the
integrity of an authors’ data posed by
manipulation of the digital file. We are not
referring here to the possibility of decep-
tion, which has been considered elsewhere
(3) and which we feel is of no greater con-
cern than the possibility of altering num-
bers in a table. It is, however, entirely con-
that an could be
unintentionally altered by an author or by

ceivable image
a printer through adjustments to contrast,
tonal range, or some other digital setting.
CBE does not have a written policy on
publishing digital images. We suggest that
at least the name of the application that
was used to create the image should be
given in the figure legend.

Tipesetter Workflow

In an ideal world, typesetters and printers
would also like to use authors’ digital
image files to improve the quality of the
printed work. It is important for managing
editors to understand, however, that
accepting files for digiral images from
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authors requires a dramatic change in the
workflow that printers have established for
electronic publishing, at least at present.
Scanning figures is an established part of
that workflow for printers who use Post-
Script-based programs for layout. It is an
efficient procedure, with well-defined time
requirements and cost per subject. Typeset-
ters have established settings for scanning
cach type of figure, which can be used by
an operator whose training is limited to the
predictable software environment of the
scanner. Using digital files received from
authors requires a more highly trained
operator who can troubleshoot images gen-
erated in a wide variety of software appli-
cations and can manipulate image files to
compensate for changes imposed by the
printer’s press curve. It also requires a large
array of peripherals to receive different
media from authors (Syquest disk drives,
ZIP disk drives, CD drives, File Transfer
Protocol [FTP] servers, etc.).

Perhaps the greatest problem for type-
setters is the undefined amount of time
that it takes to handle a digital image from
an author and the resulting difficulty in
setting charges for this work. A file for a
digital image might arrive at the printer
ready to be imported into the page layout
of the manuscript, requiring only seconds
of work by the operator to determine that
this is the case. On the other hand, the file
might be in the wrong file format (the lan-
guage used to output the information in
the file, such as PostScript, Encapsulated
PostScript, and Tagged Image File Format
or TIFF), in the wrong mode (RGB versus
CMYK), or at the wrong resolution. Some
of these problems can be corrected by a
skilled operator, but it takes time to do so.
Managing editors must provide detailed
instructions to authors, describing the cor-
rect settings for files to be used by the type-
setter and printer (see the next section). It
is important not only to indicate what the
correct settings are, but also to describe to
the author how to achieve these settings in
commonly used graphics applications.
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Guidelines for Authors

In the discussion that follows we include
information about the software applica-
tions and file formats most commonly
used by typesetters and printers. Specific
instructions are given for preparing images
with Adobe Photoshop because this appli-
cation is very commonly used by authors.
It is most important, however, for authors
to note the preferred file formats and the
resolution specifications for particular
types of images, and they can prepare
images with any software that will produce
compliant files. The specific instructions
were prepared with Adobe Photoshop ver-
sion 4.0 for Windows. The Windows and
Macintosh interfaces are similar, however,
and have not changed substantially in the
recent releases of the software.

Media

Typesetters can accept files on a wide variety
of media. The most common and easiest to
use are 3.5-inch floppy disks and 3.5-inch
ZIP disks. Floppy disks can hold up to 1.44
MB of data; ZIP disks can hold up to 100
MB. If an author sends an uncompressed file
for a halftone or color image and it fits on a
floppy disk, the file is probably too small
(too low resolution; see below). Alterna-
tively, if an image file is larger than 100 MB,
something is not right, and the authors
should check to see that they have followed
the instructions below properly.

Standard Software Applications

Just as the word-processing programs
Microsoft Word and WordPerfect have
become established software applications for
producing the text of a manuscript, there are
standard software applications that typeset-
ters use to manipulate digital images.
Authors should not worry if they are not
using one of these applications. If the image
is saved in the correct format and sent from
within the application in which it was cre-
ated, the applications that the typesetter is
using should be able to open it. This is an
important point. Authors should be
instructed 7ot to embed their images in
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another application, such as Microsoft Word
or Microsoft PowerPoint, but to send files
saved in their original format directly from
within the graphics application.

The standard applications used by most
typesetters are Adobe Illustrator for line art
and Adobe Photoshop for halftones, color
figures, and combination halftones. Illustra-
tor can create “object-based” graphics in
which fine lines, curves, and objects are
determined through mathematical defini-
tion (or vectors) and are not created with dots
(bitmapped). This means that the graphic
can be rendered at any resolution using the
vector information. Photoshop creates
bitmapped images in which the color prop-
erties of each pixel are defined.

Authors should be instructed
not to embed their images in
another application . . . but
to send files saved in their
original format directly from
within the graphics
application.

File Format: EPS versus TIFF

There are 2 standard file formats for saving
digital images. Encapsulated PostScript
(EPS) files comprise a PostScript file for
printing and a low-resolution PICT or
Tagged Image File Formart (TIFF) file for
rendering the image on a screen (4). Post-
Script is a language devised by Adobe Sys-
tems, Inc as a device-independent, page-
description language for use by a wide
variety of output devices. It is the standard
language that drives most printers and
imagesetters. Both vector-based graphics
and bitmapped images can be stored as
EPS files.

TIFF is a format for storing bitmapped
graphic images. TIFF is not a printer lan-
guage or page-definition language, but was
developed to facilitate the exchange of image
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data between application programs. TIFF
does not support object-oriented graphics or
text; it is designed solely for image data.

TIFF is the preferred file format for
image data, and EPS must be used for vec-
tor-based graphics. For color-image data,
TIFF files are smaller and print faster
because they send less information to the
imagesetter for printing each plate (when
an EPS file is processed by the imagesetter,
the entire file is processed 4 times, once for
each plate; the color information for a
TIFF file is processed only once). For black
and white (noncolor) images, TIFF is still
the preferred format. It is important to
note that both EPS and TIFF files can be
accepted by typesetters, but authors should
check with each targeted journal for its
preference. Because typesetters and print-
ers use OPI and APR workflows to speed
production, TIFF files will generally be the
preferred file format. In most cases, TIFF
or EPS files will work, but TIFF files will
generate a better preview file for authors to
view in page proof.

A preview is a version of an image that is
used primarily for viewing it on screen. Most
software applications that generate EPS files
give the user a choice of whether to create a
preview version and a choice of file format
for the preview. (The preview formats for
Macintosh and Windows computers are dif-
ferent and are not compatible.) The default
preview is at 72 dpi; this is an acceptable res-
olution for viewing an image on screen, but
renders a poor-quality image on most print-
ing and proofing devices.

If printing instructions are to be included
in the image file—such as clipping paths
(used to isolate part of an image for printing
or placement in another application), line
screens, or screen angles (a series of prede-
fined angles used to avoid moiré patterns)—
it must be saved as EPS. It is important to
note here that a PostScript file and an EPS
file are not the same thing. An EPS file is a
PostScript file whose purpose is to be placed
on a page or within another program as a
graphic. Authors should never submit Post-
Script files.



File Compression

Another reason that TIFF files are preferred
for image data is that they can be com-
pressed easily. Image files can be very large
(up to 50 MB), and various compression
schemes have been devised to store and
transport these files using less memory.
Some compression standards have been built
into the TIFF file format, such as LZW
(Lempel-Ziv-Welch) compression. This util-
ity compresses the data without deleting any
information (lossless compression). In gen-
eral, LZW is the best overall lossless com-
pression engine, but any self-extracting file-
compression system is likely to work.

Many types of compression programs are
available; the most popular are PKZIP and
WINZIP for DOS and IBM-compatible
systems and Stufflt and DiskDoubler for
Macintosh. Most typesetters and printers
can accept files compressed with these appli-
cations. Compression programs are also
available for UNIX systems, and it is impor-
tant to determine whether your printer and
typesetter can handle them.

File compression is extremely useful
when transmitting data via telecommunica-
tion—bulletin board services (BBSs) and the
Internet. A user can compress multiple files
into a single, more portable file, then easily
transfer the file between locations. However,
transferring files as attachments to e-mail is
risky and should be avoided whenever possi-
ble. Some Internet providers and e-mail soft-
ware will truncate files or change file for-
mats, rendering the attached files unusable.
It is safer and more reliable to send com-
pressed files via FTP or through a propri-
etary, secure connection like a BBS.

Grayscale Art

Submitted digital halftones must have an
image resolution of at least 300 dpi at publi-
cation size. To check the size and resolution
of the image in Adobe Photoshop, select
“Image Size” in the “Image” menu. Make
sure that the “Resample Image” box in the
“Image Size” dialog window is not checked
and that the “Width”, “Height”, and “Reso-
lution” boxes are linked by the graphic chain

(it might be necessary to click twice on the
“Resample Image” box to establish this link).
This will mean that no resolution (dots or
data) is lost when the dimensions of an
image are reduced and that the machine
does not add dots to an image when increas-
ing its dimensions. Set the print size to the
desired size of the image in the printed jour-
nal, and make sure thart the resolution at this
size is above 300 dpi. If it is not, the file
might have to be reimported at a higher res-
olution from the image-capture device that
was used. Grayscale images should be saved
in the TIFF format by selecting this choice
in the format box of the “Save” dialog win-
dow.

To compensate for dot gain in the print-
ing process (see above), typesetters will
impose dot-gain and tonal-range settings on
the file before importing it into their type-
setting applications. Authors who are inter-
ested can look at how these settings affect
the image, but it is not recommended that
they adjust these settings in the file that they
submit for the digital image. In Adobe Pho-
toshop, dot gain is set by selecting “Color
Settings” in the “File” menu, then selecting
“Printing Inks Setup”. The “Ink Colors” in
the dialog window can be left at the default
setting of “SWOP (Coated)”. Set the dot
gain, and make sure that the “Use Dot Gain
for Grayscale Images” box is checked. Tonal
range (for example, from 2% to 98%) is set
by selecting “Adjust” in the “Image” menu,
then selecting “Curves”. Click on the bot-
tom left point of the line in the dialog win-
dow and move it slightly up until the input
and output values read 0% and 2%, respec-
tively. Click on the top right point and move
it slightly down until the input and output
values read 100% and 98%, respectively. If
an author has imposed these settings on the
image in a file, it is vital that the editorial
office be informed (who in turn must
inform the typesetter) to avoid having them
adjusted another time.

Color Art
As for halftones, the resolution of color
images should be at least 300 dpi. As
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described above, color images are printed
using the 4 colors CMYK. It is important to
view the image in this mode to get a preview
of how the colors will print, although moni-
tors have various calibrations, and the colors
might still look different from how they will
look in print. All adjustments to color
should be made to the CMYK image, and it
should be saved in this mode. To change the
mode to CMYK from RGB in Adobe Pho-
toshop, select “Mode” in the “Image” menu,
then select “CMYK Color”.

The color saturation should be set to a
maximum of 280%; that is, at no point in
the image should the sum of the percent-
ages of the colors used be greater than 280.
To check this in Adobe Photoshop, make
sure that you are in CMYK mode, then
select “Show Info” in the “Window” menu,
and click on the “Info” tab. The top left
corner of the dialog window shows the per-
centages of each of the 4 colors used to
make up the color at the place in the image
where your mouse pointer is located. Make
sure that the sum of these percentages at
the darkest point in the image is less than
280. Although every attempt is made by
typesetters and printers to match the col-
ors, software might not print uniformly
across different platforms.

Line Art

Line drawings can be submitted in EPS for-
mat by selecting this option in the format
box of the “Save” window in the application
used to create the drawing. All fonts should
be saved to path, if possible; or standard
fonts—such as Helvetica, Arial, and
Times—should be used. To do this in Adobe
llustrator, first select the text, then select
“Create Outlines” in the “Type” menu. Line
art can also be submitted in TIFF file format
at 1000 dpi at publication size.

As with color and grayscale images, TIFF
remains the preferred format. The issues are
the same as those mentioned above; if an
author has the choice of providing TIFF or
EPS, it is wise to choose TIFE TIFF files,
although generally larger than EPS files, do
not have the problems of cross-compatibility
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encountered with EPS files, such as missing
fonts and font substitution.

Color or Grayscale with Fonts or Lines
Authors should follow these guidelines to
ensure that their labeled color or halftone
images are reproduced properly by the
printer.

1) Import the grayscale or color image (min-
imum resolution, 600 dpi at publication
size) into Adobe Photoshop or similar pro-
gram.

2) Crop the image.

3) In the “Layers” menu, select “New Layer”.
4) Create labels in the new layer making sure
that the anti-aliased box in the Type Tool
window is not checked.

5) Save as a TIFF file.

Hard Copy
The final request that all typesetters are mak-
ing of authors is that they send a hard copy of
the image to indicate what they expect from
the output of their file. The most important
instruction for authors sending color images
is that the hard copy should be output from a
file in CMYK mode. This will give the author
an indication of what colors the printer is
capable of achieving on paper and will serve as
a guide for the printer in establishing what the
author wants the image to look like.
Typesetters may push to scan the hard
copy if they are having trouble with the
file, but they should be encouraged to call
the editorial office to determine whether
there is any way to obtain a usable file from
the author. Managing editors trying to
convert to digital images will find that this
becomes a common task.

Conclusions

Just as it took time for journalists to accept
electronic files of manuscripts, so will it take
time for digital images created by authors to
become the industry standard. When they do,
it will mean great savings in the time, cost,
and effort of image production for both
authors and typesetters, and managing editors
will get their prize of faster turnaround of
manuscripts from acceptance to publication.
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